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Об этом руководстве  

Кому предназначено это руководство? 

Настоящее руководство предназначено для переводчиков и рецензентов. В нем 
рассматривается перевод и редактирование переведенных документов. Эти документы 
могут быть представлены единичными файлами для перевода, или файлами в составе 
проекта или подпроекта. 

Принципы работы с руководством 

Для выполнения упражнений можно использовать тестовые файлы. В основе каждого 
упражнения лежит предыдущее, поэтому при работе с тестовыми файлами инструкцию 
следует выполнять поэтапно.  
 

 

Этот значок указывает на наличие тестовых файлов для выполнения 
упражнения и их местоположение.  
 
Пути указаны для операционных систем Microsoft Windows 7 или 
Vista. В операционной системе Windows XP соответствующие файлы 
находятся в папке My Documents.    
 
 
 

Совет 
 

Этим символом помечены рекомендации с дополнительной 
информацией по выполнению соответствующей задачи. 
 
 
 

Примечание Этот значок указывает на наличие важной информации о выполняемой 
задаче. 

  
 
 

Комбинации 

клавиш 

Все используемые комбинации клавиш отображаются с использованием 
следующего шрифта:  Ctrl+Enter. 

 
 

Дополнительные источники информации 

Дополнительные источники информации: 

 SDL Trados Studio Help 

 SDL Trados Studio. Руководство по переходу с более ранних версий (SDL Trados Studio 
Migration Guide) 

 Краткое руководство по управлению проектами (Project Management Quick Start 
Guide) 

 Краткое руководство по управлению базой переводов (Translation Memory 
Management Quick Start Guide) 
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Введение в SDL Trados Studio 

Описание 

Благодаря SDL Trados Studio компании получили возможность эффективного управления 
переводческими проектами. В SDL Trados Studio объединены инструменты управления 
проектами и автоматизированного перевода (computer-aided translation, CAT), их могут 
использовать менеджеры проектов, редакторы, корректоры и другие специалисты в 
языковой области. Эти инструменты представлены в простых и понятных режимах, 
которые можно расположить в любом удобном для работы порядке. 

Режимы работы (Views) 

Для отображения определенного режима работы в SDL Trados Studio щелкните по кнопке 
с названием режима работы или значку этого режима. Кнопки вызова режимов работы 
расположены в нижней части панели навигации. 
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Режим работы 
(View) 

Описание 

Home 

В этом режиме работы можно выполнять следующие команды: 

 Открыть документ на перевод. 

 Открыть подпроект. 

 Определить глобальные настройки по умолчанию. 

При выборе одной из этих команд выполняется переход 
к соответствующему режиму работы SDL Trados Studio или 
к другому приложению, в котором можно выполнить данное 
действие. 

Projects 

Здесь осуществляется просмотр проектов и работа с ними. Можно 
выбрать проект, просмотреть подробную информацию о проекте и 
файле и отследить статус файла.  

  Files 

Здесь осуществляется работа с файлами проекта. В этом режиме 
работы можно выполнить следующие действия: 

 Открыть файлы на перевод. 

 Открыть файлы на проверку. 

 Выполнить пакетную обработку файлов. 

 Кроме того, можно увидеть количество слов и ход выполнения 
перевода этих файлов.  

  Reports 

Здесь можно просмотреть отчеты по проекту. В отчетах 
представлены данные подробного анализа, которые напрямую 
передаются в процесс планирования проекта и бюджета.  

  Editor 
Здесь выполняется перевод и редактирование документов.  

  Translation Memories 

 

В этом режиме работы осуществляется создание баз переводов и 
управление ими.  
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Потоки операций 
В SDL Trados Studio реализовано выполнение потоков операций двух типов. Эти потоки 
можно контролировать и изменять в соответствии с текущими требованиями. 

 Перевод одного файла 

 Перевод подпроекта 

Поток операций перевода одного файла 

На следующей схеме представлен возможный способ перевода в потоке операций перевода 
одного файла:  
 

 



 

 Краткое руководство по переводу и редактированию 
Стр. 9 

 

Поток операций перевода подпроекта 

На следующей схеме представлен возможный способ перевода в потоке операций перевода 
подпроекта:  
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Настройки по умолчанию для 
языковой пары 
В языковой паре сохраняются настройки, относящиеся к переводу с определенного 
исходного языка на определенный целевой язык. Как правило, настройка ресурсов и опций 
применяется ко всем языковым парам, к которым они относятся. Многоязычные ресурсы, 
такие как шаблоны и серверные базы переводов, могут относиться к нескольким языковым 
парам. Двуязычные ресурсы, такие как файловые базы переводов, относятся только 
к конкретной языковой паре.  
 
Перед началом перевода документов рекомендуется указать эти настройки по умолчанию. 
Таким образом, одни и те же настройки и ресурсы можно применить ко всем переводам. 
Например, требуется указать базу переводов, терминологическую базу данных и другие 
ресурсы для перевода текста с английского языка на немецкий.  

Диалоговое окно "Options" 

Для установки параметров настройки по умолчанию используется диалоговое окно 
Options. 
При запуске нового перевода автоматически открываются базы переводов и 
терминологические базы данных по умолчанию, а также применяются параметры 
настройки по умолчанию.  

Настройки языковой пары 

Как правило, конфигурирование ресурсов перевода (в том числе двуязычных) и 
редактирование параметров настройки выполняется на уровне All Language Pairs. Эти 
настройки применяются ко всем языковым парам, а переводческие ресурсы – ко всем 
релевантным языковым парам.  
Пример. 

 На уровне All Language Pairs выбрана многоязычная серверная база переводов, 
которая содержит языковые пары английский-немецкий и английский-французский. Эта 
база переводов используется при переводе с обеими языковыми парами.  

 Изменение минимально допустимого значения совпадения на 65% на уровне All 

Language Pairs применяется ко всем языковым парам. 

Совет 
 

Для каждой языковой пары можно определить отдельные исключения из этих 
настроек. Например, при необходимости установки другого минимально 
допустимого значения совпадения для языковой пары английский-немецкий 
его можно изменить на уровне отдельной языковой пары. 
 

http://shefftfs01.development.sheffield.sdl.corp:82/SDL%20Trados%20Studio/client_en/Edit_View/TMs/EVWorkingwithTMsAbout_Translation_Memory_Matches.htm
http://shefftfs01.development.sheffield.sdl.corp:82/SDL%20Trados%20Studio/client_en/Edit_View/TMs/EVWorkingwithTMsAbout_Translation_Memory_Matches.htm
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Ресурсы (Resources) 

Можно выбрать следующие ресурсы: 
  

Ресурс Описание 

Базы переводов 
(Translation 
Memories) 

Файловый формат базы переводов в SDL Trados Studio - .sdltm. Допускается 
использование базы переводов из SDL Trados Studio 2009 и 2011.  Для 
получения информации о процедуре обновления базы переводов из 
предыдущей версии SDL Trados или SDLX до актуального формата см. 
Руководство по переходу с более ранних версий SDL Trados Studio 2011. 
 
Также можно подключить серверные базы из систем SDL TM Server 2009 
SP3, SDL TM Server 2011 и SDL WorldServer 2011 SP1 (версия 10.1). 
 

Сервер 
автоматического 
перевода 
(Automated 
Translation Server) 

Перевод выполняется автоматически, без участия человека. Приложение для 
автоматического перевода устанавливается на сервере, доступ к которому 
осуществляется аналогично доступу к серверной базе переводов. Для 
подключения доступны следующие серверы автоматического перевода: 

 сервер автоматического перевода SDL по умолчанию; 

 SDL BeGlobal 

 Google Translate  

 
Помимо этого можно добавить собственный пользовательский сервер 
автоматического перевода.  
 

Терминологические 

базы 
 

В SDL Trados Studio 2011 используются файловые терминологические базы 
данных SDL MultiTerm 2009 и 2011 (.sdltb). Помимо этого можно 
использовать терминологические базы, созданные в более ранних версиях 
SDL MultiTerm:  

 SDL MultiTerm 2007 (версия 7.5) и предыдущие выпуски 7.x 

 SDL MultiTerm iX (версия 6.x). 

 

 

Все языковые 
пары 

Отдельные 
языковые 

пары 
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При открытии терминологических баз данных предыдущих версий 
автоматически выполняется их обновление до формата SDL MultiTerm 2011 
(.sdltb).  
 
В MultiTerm Server 2009 SP3 и MultiTerm Server 2011 можно 
подключиться к серверным терминологическим базам данных. 
 

Словари 
AutoSuggest 
 

Правка с использованием автоподстановки слов (AutoSuggest) – очень 
важная новая функция, позволяющая ускорить ручной перевод. При правке 
с использованием автоподстановки слов отслеживается вводимый текст – и 
после набора нескольких первых символов слова из базы переводов 
предлагается список слов и фраз на целевом языке, которые начинаются 
с этих символов. Для автоподстановки слов могут использоваться следующие 
источники: 

 Словари AutoSuggest – создайте новый словарь AutoSuggest или 
выберите существующий словарь, созданный каким-либо пользователем. 
В этом словаре представлены слова и словосочетания, извлеченные из баз 
переводов (.sdltm) или файлов .tmx. 

 Терминологическая база SDL MultiTerm, выбранная для проекта. 

 Записи AutoText – создайте список слов и фраз вручную путем ввода 
в SDL Trados Studio.   
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Определение настроек по умолчанию для 
языковой пары 

Установка баз переводов, терминологических баз и словарей AutoSuggest, используемых 
по умолчанию для перевода с английского языка (США) на немецкий (Германия), 
выполняется следующим образом:   
 
Примечание     Эти параметры следует устанавливать на уровне All 

Language Pairs. 
 

Данная процедура применяется и для настройки ресурсов по умолчанию для других 
языковых пар. В этом примере используется тестовый проект SDL Trados Studio. 
Ознакомьтесь с процедурой и следуйте ей для определения собственных ресурсов по 
умолчанию для всех языковых пар, с которыми ведется работа. 

1. В строке меню выберите Tools > Options. Откроется диалоговое окно Options. 

2. В дереве навигации выберите Language Pairs > All Language Pairs > 

Translation Memory and Automated Translation.  

3. На странице Translation Memory and Automated Translation можно выбрать 
файловые и серверные базы переводов. Выберите тестовый файл базы переводов 
English-German.sdltm 

. 

 

…Documents\Studio 2011\Projects\Samples\SampleProject\ 

TMs\English-German.sdltm 

 Если при настройке не используются опции для языковой пары по умолчанию, 
English (United States) - German (Germany), появится диалоговое окно Add 

Supported Language Pairs. Установите флажок рядом с языковой парой и 
нажмите кнопку OK. 
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4. В дереве навигации выберите Language Pairs > All Language Pairs > 

Termbases.  

5. На странице Termbases можно выбрать терминологические базы SDL MultiTerm. 
Выберите файл тестовой терминологической базы Printer.sdltb. 

 

 

…Documents\Studio 2011\Projects\Samples\SampleProject\ 

Termbase\Printer.sdltb 

 

 
 

6. В дереве навигации выберите Language Pairs > English (United States)-

>German (Germany) > AutoSuggest Dictionaries.  

 
Примечание     Словари AutoSuggest можно определить только на уровне отдельной 

языковой пары. 
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7. На странице AutoSuggest Dictionaries можно выбрать словари AutoSuggest. 
Выберите файл тестового словаря AutoSuggest AutoSuggest_EN-US_DE-DE.bpm. 

 

 

…Documents\Studio 2011\Projects\Samples\SampleProject\ 

AutoSuggest\AutoSuggest_EN-US_DE-DE.bpm 

 
 

8. Нажмите OK, настройки по умолчанию будут сохранены. 

 
Далее указанные ресурсы по умолчанию будут применяться при создании всех проектов 
перевода с английского языка на немецкий. 
 

Совет 
 

В древовидной структуре под All Language Pairs можно определить 
дополнительные настройки, например, минимально допустимые значения 
нечеткого совпадения и значения автозамены. Не забывайте, что эти 
настройки применяются ко всем языковым парам. Для установки параметров 
настройки, специфичных только для пары английский-немецкий, перейдите 
по пути Language Pairs > English United States) > German 

(Germany). 
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Перевод в SDL Trados Studio 

Открытие файла для перевода 

В SDL Trados Studio открыть файл для перевода можно двумя способами. Первый способ 
используется при переводе одного файла, а второй – для открытия файлов проекта или 
подпроекта.  
 

Способ 

открытия 
Описание 

Для открытия одного 
файла для перевода 

Выберите команду Open Document в режиме работы Home или в 
меню File. 

Для открытия на 
перевод файла 
проекта или подроекта 

Щелкните правой кнопкой мыши по имени файла в режиме работы 
Files и выберите Open for Translation. 
 
Все базы переводов, терминологические базы, словари AutoSuggest и 
настройки, связанные с подпроектом, откроются автоматически. 
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Открытие одного файла для перевода 

Предположим, требуется перевести SamplePhotoPrinter.doc с английского языка 
(США) на немецкий (Германия).  Для открытия файла и применения параметров 
настройки, определенных ранее в диалоговом окне Options, выполните следующие 
действия.  

1. Нажмите Open Document на панели инструментов Standard в любом режиме 
работы. Откроется диалоговое окно Open Document. 

 

2. Выберите тестовый файл и нажмите Open. Откроется диалоговое окно Open 

Document. 

 

 

…Documents\Studio 2011\Projects\Samples\SampleProject\ 

en-US\SamplePhotoPrinter.doc 
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В области Translation Memory and Automated Translation автоматически 
отображается база переводов, выбранная в предыдущем разделе.  
 

Совет 
 

Для определения дополнительных настроек нажмите Advanced. При этом 
появится терминологическая база данных и словарь AutoSuggest, указанные 
в диалоговом окне Options, а также другие параметры настройки, 
связанные с ресурсами, используемыми при переводе (минимальное 
процентное значение нечеткого совпадения, метаданные для обновления 
базы переводов и параметры поиска с помощью функции Concordance). 

3. Нажмите OK: 

  Контент документа на исходном языке, подлежащий переводу, определяется,  
разбивается на сегменты и добавляется в двуязычный файл SDLXLIFF. Файл 
откроется на перевод в окне редактирования режима работы Editor. 

 Автоматически будут открыты указанные ранее базы переводов по умолчанию, 
терминологические базы данных и словари AutoSuggest. Также будут 
автоматически применены все настройки, определенные в диалоговом окне 
Options. 

4. На панели инструментов нажмите Save Document : 

 Откроется диалоговое окно Save as. Автоматически для сохранения документа 
будет предложено имя SamplePhotoPrinter.doc_en-US_de-
DE.sdlxliff. Нажмите Save, документ будет сохранен с этим именем. 

 Автоматически будет создан проект с тем же именем, что документ: 
SamplePhotoPrinter.doc_en-US_de-DE. 
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Изменение настроек проекта 

Для изменения настроек, применяемых к файлу после его открытия, используется 
диалоговое окно Project Settings. Как правило, изменение настроек проекта 
выполняется на уровне All Language Pairs, аналогичном выбору настроек по умолчанию в 
диалоговом окне Options. 
 
Предположим, требуется изменить минимально допустимое значение совпадения для 
нечетких совпадений на 65%. Это степень совпадения между сегментом исходного 
документа и сегментом базы переводов, при достижении которой в качестве подстановки 
будет предложен сегмент перевода. Значение по умолчанию составляет 70%. 
 
Изменение минимально допустимого значения совпадения:  

1. Нажмите кнопку Project Settings в окне Translation Results.  

 

 
 
Откроется диалоговое окно Project Settings на странице Translation and Automated 

Translation для уровня All Language Pairs. 

Кнопка "Project 
Settings" 
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2. В дереве навигации выберите Language Pairs > All Language Pairs > Search. 

 

3. Измените Minimum match value в разделе Translation на 65. 

4. Нажмите OK, настройки поиска будут применены к текущему открытому документу. 

 

Совет 
 

Для получения информации о переводе документа см. Краткий обзор среды 
перевода в SDL Trados Studio. 

 
 
 
 

Страница 
"Search" 

Минимально 
допустимое 
значение 
нечеткого 
совпадения 
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Открытие на перевод файла проекта или подпроекта 

Предположим, от заказчика получен подпроект, содержащий файлы, которые требуется 
перевести или проверить. Открыть подпроект и начать его перевод можно, выполнив 
следующие шаги.  
 

Открытие подпроекта 

1. Нажмите Open Package на панели инструментов Standard в любом режиме 
работы. Откроется диалоговое окно Open Package. 

2. Выберите подпроект, который требуется открыть, и нажмите Open. Откроется 
страница Review Package Contents мастера Open Package.   

 

3. Для импорта подпроекта нажмите Finish. Откроется страница Importing Package. 

4. Если это первый открытый подпроект по данному проекту, появится диалоговое окно 
Browse For Folder. Выберите папку для сохранения содержимого подпроекта и 
нажмите OK. По умолчанию создается папка проекта с именем проекта, с которым 
связан подпроект. 

5. По окончании импорта нажмите Close для завершения работы мастера Open 

Package. В SDL Trados Studio создан и открыт проект, соответствующий 
информации о проекте, указанной в подпроекте. 

 

Для продолжения работы над этим упражнением необходим подпроект, 
созданный другим пользователем SDL Trados Studio, который можно будет 
открыть в SDL Trados Studio. 
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Открытие файла проекта 

Проект, связанный с только что открытым подпроектом, становится активным проектом. 
Теперь можно открыть на перевод файлы подпроекта. 
 

1. На панели навигации нажмите кнопку Files. Откроется режим работы Files. В нем 
представлены все файлы только что открытого подпроекта. 

 
 
 
 

 

2. Дважды щелкните по файлу SamplePhotoPrinter.doc.sdlxliff. Файл 
автоматически откроется в режиме работы Editor, будут подключены связанные базы 
переводов, терминологические базы и словари AutoSuggest, входящие в состав 
проекта или подпроекта.  

 
Примечание     Открыть файл можно и другим способом. Щелкните правой кнопкой 

мыши – и в меню быстрого вызова выберите Open For Translation, 
как показано на рисунке выше. 

 

 

Для продолжения выполнения этого упражнения используйте Sample Project. Если этот 
проект не является активным (текущим выбранным) проектом, перейдите в режим 
работы Projects и двойным щелчком мышью выберите Sample Project.  
 
…Documents\Studio 2011\Projects\Samples\SampleProject\ 

Sample Project.sdlproj 

 

В строке заголовка 
отображается имя 
активного 

проекта:  
Sample Project 
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Краткий обзор среды перевода в SDL Trados 
Studio 

В SDL Trados Studio проверка и перевод документов осуществляются в режиме работы 
Editor. Этот режим работы включает: 

 Панель навигации, на которой можно просмотреть открытые в настоящее время 
документы и выбрать требуемый. 

 Меню и панели инструментов с инструментами правки. 

 Окно редактирования, в котором осуществляется перевод и проверка. 

 В окне Translation Results отображаются результаты поиска в базе переводов и 
создаются единицы чернового автоматизированного перевода. Если автоматически 
подставленный результат не подходит, можно выбрать один из предложенных здесь 
результатов и применить к текущему сегменту. 

 Окно Term Recognition – в этом окне отображаются результаты поиска по 
терминологической базе.  

 

 

 

 

 

 

 

 

 

Окно "Translation 
Results"  

Окно "Term 
Recognition"  

Окно "Editor"  
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Подробный обзор окна редактирования (Editor) 

В окне редактирования режима работы Editor выполняется перевод документов. В этом 
окне параллельно отображаются двуязычный документ SDL XLIFF с текстом, который 
требуется перевести, и готовый перевод. Исходный текст отображается слева, а версия 
на целевом языке – справа. Содержимое документа разбито на сегменты (в основном, 
по предложениям). Целевые сегменты можно изменять. 
 

 В первом столбце отображены номера сегментов. Отображение номеров сегментов 
можно отключить. С исходными и целевыми сегментами можно работать как с двумя 
отдельными списками. 

 Между столбцами исходных и целевых сегментов расположен столбец статуса 
сегмента. Этот столбец очень важен, т.к. в нем указывается текущий статус перевода 
сегмента и источник перевода. Например, можно увидеть, что перевод утвержден, и 
в базе переводов найдено полное совпадение для этого сегмента. 

 Справа от целевых сегментов расположен столбец структуры документа. В нем указан 
код, по которому можно определить расположение текста сегмента в исходном 
документе. Для просмотра описания расположения текста сегмента в исходном 
документе наведите курсор на этот код и щелкните по коду в данном столбце. 

 

 

 

 

 

 

 

 

 

 

Закладка имени окна 
документа 

Исходный сегмент Целевые сегменты 

Статус сегмента Номера сегментов Структура документа  
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Перевод тестового документа в SDL Trados 
Studio 

В этом разделе описан перевод в SDL Trados Studio документа 
SamplePhotoPrinter.doc из тестового проекта на немецкий язык. Сначала откройте 
тестовый файл. Для получения подробной информации см. раздел Открытие файла 
проекта. 
 

 

Полные контекстные совпадения (Context Matches) 

1. Откройте тестовый документ, будет автоматически выполнен поиск совпадения для 
первого сегмента. Рассмотрим следующий пример. 

 Результаты поиска по базе переводов представлены в окне Translation 

Results, наиболее подходящий результат подставляется в целевой сегмент 
документа.  

 В базе переводов было найдено полное контекстное совпадение. Оно 
подтверждается автоматически.  Тип совпадения  отображается в столбце 

статуса сегмента, значок  указывает, что сегмент подтвержден.  

Контекстным совпадением называется 100%-ное совпадение в соответствующем 
контексте, когда, например, предшествующий сегмент в документе полностью 
совпадает с аналогичным сегментом в базе переводов. В этом случае полное 
контекстное совпадение означает, что это предложение уже было переведено 
в начале документа. Предполагается, что контекст в базе переводов совпадает 
с контекстом примера, где эта пара предложений также является первой. Правка 
полного контекстного совпадения обычно не требуется. 
 

 

SamplePhotoPrinter.doc.sdlxliff в проекте Sample Project 
 

 …Documents\Studio 2011\Projects\Samples\SampleProject\ 
Sample Project.sdlproj 
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Окно 
"Translation 
Results" 

Столбец статуса 
сегмента 
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Нечеткие совпадения (Fuzzy Matches) 

2. Поместите курсор в целевой сегмент 2. 

 В базе переводов найдены два нечетких совпадения (91% и 88%), которые 
отображены в окне Translation Results. 

 Степень нечеткого совпадения 91% является наибольшей, поэтому данное 
совпадение автоматически подставляется в целевой сегмент документа. 

Совет 
 

Изменить настройки, в соответствии с которыми в документ подставляется 
нечеткое совпадение наибольшей степени, можно в диалоговом окне 
Options на Editor > Automation. Для вызова диалогового окна выберите 
Tools > Options. 

 
 

 
 

Совпадение 
91% 

Совпадение 
88% 

Автоматически 
подставлено 
совпадение 
91% 
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Совпадения из терминологической базы 

При перемещении курсора в сегмент 2 также был выполнен поиск по терминологической 
базе. В терминологической базе данных был найден термин Photo printer. В исходном 
сегменте он выделяется красными скобками. 
 

 
 
В окне Term Recognition отображается перевод термина, Fotodrucker.  Этот перевод уже 
подставлен в целевой сегмент, т.к. он был найден в базе переводов.   
 
Примечание     Для подстановки перевода термина нажмите Ctrl+Shift+L, выберите 

Insert term translation  в окне Term Recognition или 
Translation > Show Translated Terms в строке меню. 
 

 

Правка перевода 

3. Измените текст в сегменте 2 на Aufstellungsort für Ihren Fotodrucker finden. Для этого 
щелкните по целевому сегменту. Для правки сегмента и удаления слова Geeigneten 
можно использовать стандартные возможности правки текста Windows. 

Выделенный 
термин 

Окно "Term 
Recognition" 
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Орфографические ошибки 
При наличии орфографической ошибки ошибочно написанное слово подчеркивается 
красной волнистой линией. В сегменте 2 красной волнистой линией подчеркнуто слово 
Fotodrucker. 
 

 

4. Предположим, в этом переводе требуется использовать вариант написания 
Fotodrucker. Щелкните правой кнопкой мыши и выберите Add to Dictionary 
в меню быстрого вызова. Термин будет добавлен в пользовательский словарь, и 
красная волнистая линия исчезнет. 

Совет 
 

Для просмотра пользовательских словарей и содержащихся в них слов 
выберите Custom Dictionaries в диалоговом окне Options по пути 
Editor > Spelling. Для вызова диалогового окна выберите Tools > 

Options. 
 

Подтверждение перевода 

5. Перевод сегмента 2 выполнен. Для подтверждения перевода нажмите Ctrl+Enter 

или кнопку Confirm (Translated)  на панели инструментов Translation and 

Review. Это означает, что перевод полностью завершен. После подтверждения 
перевода: 

 Статус сегмента изменяется на Translated, в столбце статуса сегмента 

отображается следующий значок:  

 Перевод автоматически вносится в базу переводов. Если используется проектная 
база переводов, то перевод вносится именно в эту базу, а не в основную. 

 

Примечание     Для получения дополнительной информации см. раздел About 
Updating a Translation Memory SDL Trados Studio Help.  

Орфогра-

фическая 
ошибка 

http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Edit_View/TMs/AUpdTM.htm
http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Edit_View/TMs/AUpdTM.htm
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Штрафы за несоответствие форматирования 
(Formatting Penalties) 

После подтверждения перевода курсор автоматически перемещается в следующий 
неподтвержденный сегмент. Для сегмента 3 в базе переводов имеется совпадение на 98%. 
Найденный в базе переводов текст является правильным переводом. Однако в новом 
исходном сегменте используется форматирование, отличное от форматирования в базе 
переводов, к нему применен 2%-ный штраф. 

6. Значок  в окне Translation Results свидетельствует о наличии штрафа за 
несоответствие форматирования. Для просмотра информации о штрафе наведите 
указатель мыши на этот значок. 

 
  

 

Примечание     По умолчанию в SDL Trados Studio распознанные теги форматирования 
(в данном примере полужирный шрифт и курсив) скрыты.  При вставке 
теги остаются скрытыми, а текст форматируется в стиле, показанном 
в окне "Editor". 

Значок 
штрафа за 
несоот-

ветствие 
формати-

рования  

Информация 
о штрафе  
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Применение форматирования 

7. Часть текста в сегменте 3 выделена полужирным шрифтом (in a dry location), а 
часть – курсивом (direct sunlight). Применить форматирование к тексту перевода 
можно одним из следующих способов: 

Способ 1 

Требуемое форматирование можно выбрать в выпадающем списке QuickPlace. Этот список 
называется "QuickPlace", поскольку с его помощью можно быстро поместить элементы из 
исходного сегмента в целевой, например, теги, цифры, даты и другие типы 
подстановочных элементов. Для получения дополнительной информации см. Вставка 
подстановочных элементов (Placeables). 
 
Применение форматирования из выпадающего списка QuickPlace: 

 В целевом сегменте выберите текст an einem trockenen Ort и нажмите 
Ctrl+,(запятая). Под целевым сегментом отображается раскрывающийся 
список "QuickPlace" с опциями форматирования. Текст с форматированием, 
примененным в исходном сегменте, выделяется полужирным шрифтом.  

 

 Для выбора первого образца текста из списка, в котором используется 
полужирный шрифт, нажмите Enter или Tab. 

 

 

 Повторите вышеперечисленные шаги для выделения курсивом текста keinem 
direkten Sonnenlicht. На этот раз в выпадающем списке QuickPlace выберите 
образец текста, выделенный курсивом. 

Выпадающий 
список 
QuickPlace 

образец текста с 
полужирным 
начертанием 
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Способ 2 

Кроме того, форматирование можно выбрать на панели инструментов QuickInsert. При 
этом к переводу можно даже применить форматирование, которое отсутствует в исходном 
сегменте. 

 В целевом сегменте выберите текст an einem trockenen Ort и нажмите  на 
панели инструментов QuickInsert или нажмите Ctrl+B. 

 В целевом сегменте выберите текст keinem direkten Sonnenlicht и нажмите  на 
панели инструментов QuickInsert или Ctrl+I. 

 

 
 

8. Для подтверждения перевода нажмите Ctrl+Enter. 
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Проверка  

В SDL Trados Studio предусмотрены инструменты проверки переведенного текста в целях 
контроля единства терминологии и исправления ошибок. Проверка выполняется 
автоматически после подтверждения сегмента перевода, а обнаруженные ошибки 
отображаются в окне Messages. В SDL Trados Studio реализованы следующие 
инструменты проверки: 
 

Проверка Описание 

Проверка тегов  

Во время проверки содержащиеся в целевом тексте теги 
сравниваются с тегами исходного текста, и выявляются внесенные 
изменения. Изменения в целевом тексте допустимы, если синтаксис 
тегов не изменен, и переведенный документ может быть 
конвертирован в исходный формат. Благодаря проверке тегов 
обеспечивается внесение только допустимых изменений. 
Настройки этого инструмента проверки определяются для каждого 
отдельного типа файла. 

QA Checker 3.0 

QA Checker 3.0 представляет собой набор параметров для 
проверки качества. Проверке подлежат следующие области: 
проверка на уровне сегментов, исключаемые сегменты, пунктуация, 
числа, 
регулярные выражения, список слов, единство терминологии, 
проверка товарных знаков и пр. 

Проверка терминологии 

С помощью этого инструмента выполняется проверка документа на 
использование терминов на целевом языке из терминологической 
базы SDL MultiTerm и отсутствие запрещенных терминов. 

9. В базе переводов отсутствует совпадение для сегмента 4, поэтому целевой сегмент не 
заполнен. В данном примере введите следующий некорректный перевод с неверным 
числом Lassen Sie 11 cm Abstand. и нажмите Ctrl+Enter для подтверждения 
перевода и выполнения выверки. 

 

 

 При обнаружении ошибки в столбце статуса сегмента появится символ . Для 
просмотра краткого описания ошибки наведите курсор на этот символ. 

 

 
 

  

Символ  
ошибки  
в  
Столбце 
статуса 
сегмента 

Подстано-

вочный 
элемент 
(Placeable) 
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Ошибка обозначает, что в переводе отсутствует число (Вставка подстановочных 
элементов (Placeables)) из исходного сегмента. В переводе введено 11 cm, а должно 
быть, как в исходном сегменте, 12 cm. 

10. Для просмотра подробной информации об ошибке: 

 Откройте вкладку Messages для вызова окна Messages. 

 

 Щелкните правой кнопкой мыши по сообщению об ошибке и выберите Show 

Message Details. 

 
 
В поле Problem Description содержится дополнительная информация и вариант 
решения проблемы путем изменения числа. 

 Для возврата в окно "Editor" и исправления ошибки в примере на следующей 
странице нажмите кнопку Close.   

Окно 
"Messages" 

Щелкните правой кнопкой 
мыши  
и выберите  
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Совет 

Для проверки всего документа нажмите F8.  
Далее в диалоговом окне Verification Message Details можно проверить 
и, в некоторых случаях, исправить эти ошибки. Для получения 
дополнительной информации см. онлайн-справку по SDL Trados Studio (SDL 
Trados Studio Online Help).   

Вставка подстановочных элементов (Placeables) 

Подстановочные элементы – это контент исходного документа, который не требует 
перевода и/или может быть локализован автоматически путем подстановки из базы 
переводов (например, числа, даты, символы и т.д.). В окне редактирования 
подстановочные элементы выделяются синей скобкой.  

11. Правка перевода в сегменте 4 и вставка корректного подстановочного  
элемента (12 cm): 

 Удалите текст из целевого сегмента. 

 Скопируйте или введите в целевой сегмент следующий текст:  Auf der Rückseite 
des Fotodruckers sollte für problemlosen Papiertransport ein Abstand von 
mindestens 

 Нажмите Ctrl+,(запятая). Появится выпадающий список QuickPlace.  
В рассмотренном ранее примере в выпадающем списке QuickPlace 
отображалось форматирование, теперь в нем представлено число из исходного 
сегмента, которое можно вставить в целевой сегмент. 

 
 
 

 

 Для выбора 12 cm из списка нажмите Enter или Tab. 

 Скопируйте или введите остальной текст перевода:  gelassen werden. 

 Для подтверждения перевода нажмите Ctrl+Enter. На этот раз при проверке 
ошибки не обнаружены. 

Выпадающий 
список 
QuickPlace 
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Использование автоподстановки слов (AutoSuggest) 

При правке с использованием автоподстановки слов (AutoSuggest ) отслеживается 
вводимый текст и, после набора нескольких первых символов слова, из источников 
автоподстановки предлагается список слов и фраз на целевом языке, которые начинаются  
с этих символов. Источники автоподстановки слов: терминологические базы, словари 
AutoSuggest (двуязычные фрагменты предложений из баз переводов) и записи AutoText.  
Для получения дополнительной информации см. Ресурсы (Resources). 

12. Использование автоподстановки слов при переводе сегмента 9: 

 Поместите курсор в сегмент 9. Введите букву "H". Под сегментом появится 

список предлагаемых слов. Предлагается использовать Hinweis. Значок  
указывает на то, что источником предлагаемого варианта является база 
переводов. Для вставки этого варианта нажмите клавишу Enter. 

 

 Введите двоеточие : и нажмите Ctrl+Enter для подтверждения сегмента.  

13. Курсор автоматически переместится на сегмент 10. Перевод сегмента с 
использованием автоподстановки слов: 

 Введите следующий перевод, используя предлагаемые слова из списка  
(выделенные полужирным буквы указывают на слова или фрагменты, которые 
можно вставить из списка предлагаемых слов после ввода первой буквы): 
Verwenden Sie ausschließlich das Netzteil, das im Lieferumfang des Druckers 
enthalten ist. 

 Введите F из слова Fotodrucker. Предложены следующие варианты. В списке 
представлены варианты из терминологической базы и из базы переводов. Значок 

 указывает, что источником предлагаемого варианта является 
терминологическая база. В этом случае слово Fotodrucker встречается в списке 
дважды, т.к. оно было найдено и в терминологической базе, и в базе переводов. 
Обнаружение предлагаемого перевода в двух источниках обеспечивает более 
точный перевод.  

 С помощью клавиш со стрелками выберите любой вариант Fotodrucker и 
нажмите Enter для вставки выбранного варианта. 

Список 
предлагаемых 
слов 
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 Для подтверждения сегмента нажмите Ctrl+Enter. 
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Предварительный просмотр переведенного документа 

В ходе работы можно использовать предварительный просмотр переведенного документа. 
Предварительный просмотр в режиме реального времени позволяет видеть изменения по 
мере набора текста. Окно предварительного просмотра обновляется каждый раз при 
подтверждении сегмента. Этот тип предварительного просмотра доступен для часто 
используемых форматов, например, Microsoft Word и HTML. 
 
Примечание Предварительный просмотр документа возможен в приложении, 

в котором он был создан, либо в браузере в виде двуязычного 
документа. Для получения дополнительной информации см. SDL 
Trados Studio Help. 

14. Предварительный просмотр перевода: 

 Наведите указатель мыши на закладку Preview в правой части приложения.  

 

 Откроется окно Preview. Для закрепления окна на экране щелкните по значку 
с кнопкой . Окно предварительного просмотра закреплено внизу справа. 

 

 В окне Preview выберите ссылку Click here to generate initial preview. 
Документ отображается в окне Preview. 

Закладка 
"Preview" 

Щелкните, 
чтобы окно не 
закрывалось.  

Щелкните для 
создания 
предварительного 
просмотра. 
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В окне Preview отображается переведенный и подтвержденный контент, а также контент 
на английском языке, который еще не был переведен и подтвержден. Текущий выбранный 
сегмент (сегмент 11) выделен серым цветом.  Отображается его исходный текст на 
английском языке, т.к. этот сегмент еще не переведен. 
 

 
 

 Скопируйте или введите в целевой сегмент 11 следующий перевод, используя 
автоподстановку слов (выделенные полужирным буквы указывают на слова или 
фрагменты, которые можно вставить из списка предлагаемых слов после ввода 
первой буквы): 

Andere Adapter können Ihre Kamera, Fotodrucker bzw. Computer beschädigen. 

 Для подтверждения перевода нажмите Ctrl+Enter. Окно Preview обновится, 
будет отображен новый перевод. 

 

 

Выделенный 
сегмент 
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Перевод тестового документа с применением 
функции PerfectMatch 

PerfectMatch относится к форме контекстного соответствия, при котором обновленные 
исходные файлы сравниваются с соответствующим набором существующих двуязычных 
документов, а не с базой переводов.  
 
Совпадающие сегменты, называемые единицами PerfectMatch, проверяются в контексте, 
т.е. проверяется соответствие соседних записей. Далее они извлекаются из существующих 
двуязычных документов и переносятся в обновленные исходные файлы. Поскольку при 
сопоставлении сегментов с применением функции  PerfectMatch выполняется проверка 
контекста, единицы PerfectMatch, как правило, не требуют перевода или редактирования 
в процессе перевода. 

Перевод с применением единиц PerfectMatch  

Предположим, что тестовый документ о фотопринтере, перевод которого рассматривался 
в предыдущем упражнении, полностью переведен и отредактирован. После выхода версии 
2 фотопринтера в документацию к этой версии был добавлен новый текст.  
 
Поскольку документ во многом совпадает с предыдущим документом, при 
предварительном переводе файла менеджер проекта применил функцию PerfectMatch. При 
этом единицы перевода были извлечены из ранее переведенного документа и перенесены 
в новую версию документа в виде единиц PerfectMatch. 

1. На панели навигации нажмите кнопку Files. Откроется режим работы Files.  

2. Щелкните правой кнопкой мыши по файлу TryPerfectMatch.doc.sdlxliff и 
в контекстном меню выберите Open for Translation. Файл автоматически откроется 
в режиме работы Editor. 

3. Для большинства сегментов в документе были найдены единицы PerfectMatch. 
Единицы перевода PerfectMatch: 

  – показать источник перевода, который указывает тип совпадения 
PerfectMatch. 

   – определить статус сегмента Signed off. Это означает, что дальнейший 
перевод или редактирование сегмента не требуется. 

  – заблокировано с целью предотвращения случайного изменения, поскольку 
дополнительная обработка сегмента не требуется. 

 

Для продолжения выполнения этого упражнения используйте Sample Project. Если этот 
проект не является активным (текущим выбранным) проектом, перейдите в режим 
работы Projects и двойным щелчком мышью выберите Sample Project.  
 
…Documents\Studio 2011\Projects\ Samples\SampleProject\ 
en-US\TryPerfectMatch.doc  
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Использование фильтра для поиска нового контента 

4. Для поиска нового контента в документе, не переведенного с помощью функции 
PerfectMatch, используется фильтр просмотра: 

 Откройте панель инструментов Display Filter путем выбора View > Toolbars 

> Display Filter в меню. 

 

 
 

 Выберите Not Translated в раскрывающемся списке Display.  

5. Появится сегмент 8. Это единственный сегмент в этом документе, который требуется 
перевести. 

 Введите перевод Dies ist ein neuer Satz.  

 

 Для подтверждения перевода нажмите Ctrl+Enter. 

6. Перевод документа завершен. Для сохранения изменений и закрытия документа 
нажмите кнопку Save .  

Теперь редактору требуется просмотреть только новый контент в сегменте 8, поскольку все 
единицы PerfectMatches уже прошли процесс редактирования.   

Единицы 
перевода 
PerfectMatch  
со статусами 
"Locked" и 
"Signed Off" 

Новый контент 

Раскрываю 

щийся  

список 

 Display 
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Редактирование в SDL Trados Studio 
После перевода обоих документов переводчик или назначенный редактор может выполнить 
редактирование перевода. Если после выполнения упражнений предыдущего раздела 
документ все еще открыт, сохраните и закройте его. 
 

Открытие и редактирование тестового файла  

 

1. На панели навигации нажмите кнопку Files. Откроется режим работы Files. 

 

2. Щелкните правой кнопкой мыши по файлу 
SamplePhotoPrinter.doc.sdlxliff, и в меню быстрого вызова выберите Open 

for Review. Файл автоматически откроется в режиме работы Editor. 

 

 
 

 

 

Для продолжения выполнения этого упражнения используйте Sample Project. Если этот 
проект не является активным (текущим выбранным) проектом, перейдите в режим 
работы Projects и двойным щелчком мышью выберите Sample Project.  
 
…Documents\Studio 2011\Projects\Samples\SampleProject\ 

Sample Project.sdlproj 

 

 

 

SamplePhotoPrinter.doc.sdlxliff в проекте Sample Project 
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При открытии файла на редактирование формат экрана в режиме Editor изменяется на 
режим редактирования. В списке доступных статусов для изменений сегментов 
отображаются только статусы редактирования.  
 

 

Подтверждение перевода 

После редактирования сегмент необходимо подтвердить, то есть принять или отклонить 
перевод. 

3. Поместите курсор на целевой перевод в сегменте 1 и нажмите кнопку Ctrl+Enter 
или выберите Confirm (Translation Approved)  на панели инструментов 
Translation and Review для принятия перевода. После подтверждения перевода: 

 Статус сегмента изменится на Approved, в столбце статуса сегмента появится 
следующий значок:  

 Также выполняется проверка на уровне сегмента. Ошибки, найденные в 
результате проверки на уровне сегментов, выводятся в окне Messages. 

 
 

 
 
 

Принятый 
перевод 

В верхней 
части 
экрана 
отобража-

ется окно 
"Editor".  
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Отклонение перевода с применением функции 

отслеживания изменений 

С помощью функции "Track Changes" можно просматривать изменения в тексте перевода 
параллельно с исходным текстом. При этом можно сравнивать варианты редактора с 
исходным текстом. Эта функция активируется автоматически при выполнении команды 
Open for Review. 
 
Текущий перевод слова photo printer в сегменте 2 – Fotodrucker. Предположим, заказчик 
требует изменить перевод на Drucker. С помощью функции "Track Changes" предложите 
замену для перевода Fotodrucker. 

4. При подтверждении перевода на последнем шаге курсор автоматически 
устанавливается в следующем неподтвержденном сегменте, т.е. сегменте 2.  Удалите 
термин Fotodrucker и введите термин замены, Drucker. В результате этих действий: 

 Термин Fotodrucker будет зачеркнут красной линией, что означает удаление 
этого слова. Термин Drucker будет подчеркнут зеленой линией, что означает 
добавление этого слова. После получения текста на доработку переводчик 
может щелкнуть правой кнопкой мыши на каждом варианте редактора для 
принятия или отклонения изменений. 

 Статус сегмента изменится на Rejected, в столбце статуса сегмента появится 
следующий значок: . 

 

 
 

Отклонение перевода с применением комментариев 

В комментариях можно пояснить, в чем именно состоит некорректность перевода. 
Комментарий можно добавить к текущему сегменту, выделенному тексту или ко всему 
документу. 
 
Добавьте комментарий с разъяснением причин замены термина Fotodrucker на Drucker в 
сегменте 2. 

5. В переводе сегмента 2 путем выделения выберите FotodruckerDrucker и нажмите 
Ctrl+Shift+N или щелкните правой кнопкой мыши и в контекстном меню выберите 
Add Comment.  

Отслеживание 
изменений 

Автоматически 
отклоненный 
перевод 
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6. Заполните данные в диалоговом окне, как показано ниже, и нажмите кнопку OK для 
добавления комментария: 

 
 

Добавленный комментарий отображается в окне Comments.  При добавлении 
комментария: 

 Текст, к которому прикреплен комментарий, выделяется бледно-красным. Это 
означает уровень серьезности комментария "Error" (Ошибка). 

 Если сегмент еще не отклонен, его статус изменяется на Rejected, а в столбце 
статуса сегмента отображается следующий значок: . 

Совет 
Текст в прикрепленном комментарии можно выделить бледно-
желтым, что означает уровень серьезности "For your information" 
(Для информации), или бледно-оранжевым (Предупреждение). 

 

 
 

Выделение 
красным 
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Отклонение перевода вручную 

Отклонить сегменты можно вручную. Поскольку в комментарии указано, что следует 
использовать термин Drucker вместо Fotodrucker, отклоните все переводы, в которых 
присутствует этот термин. 

7. Установите курсор на сегменте 3, нажмите Ctrl+Shift+Enter или нажмите кнопку 
Reject (Translation Rejected)  на панели инструментов Translation and 

Review для отклонения перевода.  

Статус сегмента изменится на Rejected, в столбце статуса сегмента появится следующий 
значок: . 
 
 

 

Подтверждение оставшихся сегментов 

Предположим, проверка документа выполнена и остальные сегменты перевода не 
отклонены. Подтвердить все оставшиеся сегменты можно одновременно. 

8. Подтверждение всех сегментов, которые не были отклонены или утверждены: 

 Щелкните по .  

 Появится запрос. Ознакомьтесь с сообщениями и выберите Yes. 

 Всем сегментам перевода, статус которых отличен от Translation Approved и 
Translation Rejected, будет присвоен статус Translation Approved, 
документ будет сохранен и закрыт. 

 

Отклонено 
вручную 
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Внесение исправлений  

При редактировании документа или внесении исправлений в отредактированный документ 
с помощью фильтров можно просмотреть только те единицы перевода, которые требуется 
отредактировать или исправить.  

Фильтры просмотра при редактировании сегментов 

В SDL Trados Studio есть фильтры, с помощью которых можно просматривать только 
переводы на редактирование и отфильтровывать все остальные. При редактировании 
документа или внесении исправлений по замечаниям редактора применяется две ключевые 
категории.  
 

Категории фильтров 

редактирования 
Описание 

Segment Review Statuses  

Этот фильтр используется для просмотра единиц перевода по 
статусу подтверждения.  
 
Например, можно просмотреть только сегменты со статусом 
Translation rejected. При этом можно будет 
редактировать все сегменты с этим статусом, если требуется. 

Segment Review 

Этот фильтр используется для просмотра единиц перевода, 
для которых имеются: 
 

 комментарии с обратной связью; 
 отслеженные изменения; 
 сообщения с информацией по ошибкам проверки. 

 
Для применения этих фильтров используется панель инструментов Display Filter. Для 
вызова панели инструментов Display Filter выберите View > Toolbars > Display 

Filter в меню. 
 

 

Проверка  

Фильтры 
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Использование фильтров просмотра 

Предположим, переводчик получил от редактора указания на внесение исправлений. Для 
просмотра переводов, которые требуется исправить, используются фильтры просмотра. 
 
Если после выполнения упражнений предыдущего раздела документ все еще открыт, 
сохраните и закройте его. 
 

1. В режиме Files щелкните правой кнопкой мыши по файлу 
SamplePhotoPrinter.doc.sdlxliff и в контекстном меню выберите Open 

for Translation. Файл автоматически откроется в режиме работы Editor. 

2. Для просмотра любого контента, который требуется исправить, можно отфильтровать 
только единицы перевода со статусом Translation Rejected.  

 Для вызова панели инструментов Display Filter выберите View > Toolbars > 

Display Filter в меню. 

 

 
 

 Выберите Translation Rejected в раскрывающемся списке Display.  

Отображаются сегменты 2 и 3. Оба сегмента были отклонены редактором в последнем 
упражнении, поскольку заказчик потребовал использовать термин Drucker вместо 
Fotodrucker. 
 

 

Принятие предложенных изменений (отслеживание 

изменений) 

3. Примите предложенные изменения: 

 Установите курсор на середину термина Fotodrucker и нажмите Ctrl+Shift+F9, 
или щелкните правой кнопкой мыши и выберите Accept Change. Слово будет 
удалено из перевода. 

 Выполните аналогичное действие с другим изменением, Drucker.  

 Для подтверждения перевода нажмите Ctrl+Enter. 

 

Для продолжения выполнения этого упражнения используйте Sample Project. Если этот 
проект не является активным (текущим выбранным) проектом, перейдите в режим 
работы Projects и двойным щелчком мышью выберите Sample Project.  
 
…Documents\Studio 2011\Projects\Samples\SampleProject\ 

Sample Project.sdlproj 

 

Раскрываю-

щийся  

список 

 Display 

Фильтр для 
просмотра 
единиц перевода 
со статусом 
Translation 

Rejected 
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Создание переведенного документа 
Предположим, перевод тестового документа выполнен. Создайте окончательную версию 
переведенного документа.  

4. Если файл SamplePhotoPrinter.doc.sdlxliff закрыт, откройте его снова в 
режиме Editor. 

5. В строке меню выберите File > Save Target As. 

 Сохраните окончательный вариант документа в формате Word, например как 
SamplePhotoPrinter-Translated.doc 
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Возврат работы  
Предположим, перевод всех полученных в подпроекте файлов выполнен и требуется 
вернуть работу заказчику (как правило, менеджеру проекта).  Возврат работы выполняется 
в виде завершенного подпроекта (return package). После создания подпроекта его можно 
отправить по электронной почте, выложить на сервер FTP или использовать другой 
предпочтительный способ отправки. 
 
Примечание Этот способ возврата работы используется только в том 

случае, когда файлы на перевод были получены в составе 
подпроекта. 
 

Создание завершенного подпроекта 

1. В строке меню выберите Project > Create Return Package. Откроется страница 
Select Files мастера Create Return Package. В списке представлены все файлы 
проекта, кроме справочных файлов. 

 

 

В тестовом проекте "Sample Project" опция создания завершенного подпроекта 
недоступна, т.к. файлы не были получены в составе подпроекта. 

2. Нажмите Next, откроется страница Return Package Options. 

3. Нажмите Browse, появится диалоговое окно Save Return Package. Перейдите к 
папке, в которой следует сохранить завершенный подпроект, введите 
SampleProjectReturn в качестве имени завершенного подпроекта в поле File 

name и нажмите Save. 

4. При необходимости добавления комментария к завершенному подпроекту, введите его 
в поле Comment. 

5. Нажмите Finish для создания подпроекта и перехода на страницу Creating Return 

Package. 

6. После завершения создания подпроекта, статус рядом с именем подпроекта изменится 
на Completed.   

7. Завершенный подпроект можно отправить соответствующему сотруднику по 
электронной почте. Для этого нажмите Send Packages by Email.  

8. Или, если отправка подпроекта выполняется другим способом, например, через сервер 
FTP, нажмите Open Target Folder, откроется папка, в которой сохранен 
завершенный подпроект. 

9. Нажмите кнопку Close для завершения работы мастера Create Return Package. 
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Заключение 
В руководстве были рассмотрены перевод и редактирование документов в SDL Trados 
Studio. Для получения дополнительной информации о переводе и редактировании 
документов в SDL Trados Studio см. SDL Trados Studio Help. Для вызова этой справочной 
системы выберите Help > Help Topics в строке меню приложения SDL Trados Studio. 
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